How-to Guide
SAP NetWeaver ‘04
SAP NetWeaver 7.0

How To…
Use Interactive
Forms in BSP
Applications
Version 1.00 – August 2007
Jeff Gebo – SAP Labs LLC

Applicable Releases:
SAP NetWeaver ’04
SAP NetWeaver 7.0
Requires Adobe Documents Services (ADS) to be
installed & configured.
Requires knowledge of BSP Application
programming.

© Copyright 2005 SAP AG. All rights reserved.
No part of this publication may be reproduced or
transmitted in any form or for any purpose without the
express permission of SAP AG. The information
contained herein may be changed without prior notice.
Some software products marketed by SAP AG and its
distributors contain proprietary software components of
other software vendors.
Microsoft, Windows, Outlook,and PowerPointare
registered trademarks of Microsoft Corporation.
IBM, DB2, DB2 Universal Database, OS/2, Parallel
Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400,
iSeries, pSeries, xSeries, zSeries, z/OS, AFP, Intelligent
Miner, WebSphere, Netfinity, Tivoli, and Informix are
trademarks or registered trademarks of IBM Corporation
in the United States and/or other countries.
Oracle is a registered trademark of Oracle Corporation.
UNIX, X/Open, OSF/1, and Motif are registered
trademarks of the Open Group.
Citrix, ICA, Program Neighborhood, MetaFrame,
WinFrame, VideoFrame, and MultiWin are trademarks
or registered trademarks of Citrix Systems, Inc.
HTML, XML, XHTML and W3C are trademarks or
registered trademarks of W3C®, World Wide Web
Consortium, Massachusetts Institute of Technology.
Java is a registered trademark of Sun Microsystems, Inc.
JavaScript is a registered trademark of Sun Microsystems,
Inc., used under license for technology invented and
implemented by Netscape.
MaxDB is a trademark of MySQL AB, Sweden.
SAP, R/3, mySAP, mySAP.com, xApps, xApp, and other
SAP products and services mentioned herein as well as
their respective logos are trademarks or registered
trademarks of SAP AG in Germany and in several other
countries all over the world. All other product and
service names mentioned are the trademarks of their
respective companies. Data

contained in this document serves informational
purposes only. National product specifications may vary.
These materials are subject to change without notice.
These materials are provided by SAP AG and its affiliated
companies ("SAP Group") for informational purposes
only, without representation or warranty of any
kind, and SAP Group shall not be liable for errors or
omissions with respect to the materials. The only
warranties for SAP Group products and services are those
that are set forth in the express warranty statements
accompanying such products and services, if any.
Nothing herein should be construed as constituting an
additional warranty.
These materials are provided “as is” without a warranty
of any kind, either express or implied, including but not
limited to, the implied warranties of merchantability,
fitness for a particular purpose, or non-infringement.
SAP shall not be liable for damages of any kind including
without limitation direct, special, indirect, or
consequential damages that may result from the use of
these materials.
SAP does not warrant the accuracy or completeness of
the information, text, graphics, links or other items
contained within these materials. SAP has no control
over the information that you may access through the
use of hot links contained in these materials and does not
endorse your use of third party web pages nor provide
any warranty whatsoever relating to third party web
pages.
SAP NetWeaver “How-to” Guides are intended to
simplify the product implementation. While specific
product features and procedures typically are explained
in a practical business context, it is not implied that those
features and procedures are the only approach in solving
a specific business problem using SAP NetWeaver. Should
you wish to receive additional information, clarification
or support, please refer to SAP Consulting.
Any software coding and/or code lines / strings (“Code”)
included in this documentation are only examples and
are not intended to be used in a productive system
environment. The Code is only intended better explain
and visualize the syntax and phrasing rules of certain
coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall
not be liable for errors or damages caused by the usage of
the Code, except if such damages were caused by SAP
intentionally or grossly negligent.

1 Scenario
You want to use Interactive Forms in ABAP BSP applications.

2 Introduction
Using Adobe Interactive Forms in BSP applications isn’t much different from doing just
standard print forms from BSP. It just takes an understanding of a few details as well as
the iXML library to parse the result that is passed back from the Interactive Form. The
following tutorial will guide you through creating the Interactive Form, creating a BSP
application that uses the Form, and parsing the data returned by the form with the iXML
API.
Please note, this tutorial requires that you have access to a SAP NetWeaver ’04 (or
2004s) AS ABAP that is configured to communicate with an Adobe Documents Server
(ADS). In addition, to complete the tutorial fully it is required that the Flight Data model
on the AS ABAP has been populated. If it is not, you can still accomplish most of the
tutorial and will still gain an understanding of how to use this technology. Knowledge of
BSP Application programming is required to complete this tutorial.
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3 The Step By Step Solution

3.1

Create the Form Interface. This will be a simple interface that accepts
flight booking data to be entered.

1. Go to transaction SFP. Select the
Interface radio button.

2. Enter the Interface name in the
corresponding input field:
Z_CUST_FLIGHT_BOOKING_<U
SERNAME>.

3. Click Create, enter a description
and save the interface a local
object.
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4. Double click on the
Import item
shown on the left hand pane…this
will allow you to enter new
elements for the form interface.

5. Click the create icon
on the
right hand pane to insert a new
row into the import interface.
6. Enter the parameter name
“Reserved”, with type
BAPISBODAT-RESERVED.
7. Click the create icon
again to
insert another new row into the
import interface.
8. Enter the parameter name
“BOOKING_DATA”, with type
BAPISBONEW.
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9. Save and Active the interface. You
now have a simple interface that
takes a reserved flag and new
flight booking data structure. The
next step is to use this form
interface in a form.
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3.2

Create the Form, using the Form Interface that you created in the last
step. This will be a simple form that will allow users to enter
information for booking a flight.

1. Go to transaction SFP. Select the
Form radio button.

2. Enter the Interface name in the
corresponding input field:
Z_CUST_FLIGHT_BOOKING_<US
ERNAME>.
3. Click Create.

4. Enter a description and the name of
the interface you created in the last
section (in this case it is the same
name as the form you are creating).
5. Click Save, and save the Form as a
local object.
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6. Drag and Drop the “RESERVED”
element found under Import on the
left hand pane, the context node on
the right hand pane.
7. Do the same with the
BOOKING_DATA element. Since
BOOKING_DATA is a structure you
will see it expanded as shown to the
right.
8. Save your form.

9. Select the Layout tab of your form.
This will launch the Adobe
LiveCycle Designer.
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10. In the LiveCycle Designer, drag
and drop the BOOKING_DATA
node from the Data View to the
form.
11. Do the same for the RESERVED
data element.

12. Change the RESERVED UI
Element into a checkbox. To do this,
select the UI element, then in the
Object tab in the object palette on
the right; select the Field sub-tab.
Change the Type dropdown to be
Check Box.

13. Modify the rest of the form as you
see fit. Add a header and a logo on
the Master page. Change the
BOOKING_DATA format. Make the
labels more readable.
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14. Add a UI element “Button” to the
form from the Standard Library.

15. Set the proper properties on the
button to call a BSP controller and
to pass XML data.
Select the Submit Button, and then go to
the Object > Field tab on the right hand
side. Set the Caption to “Submit”. Set
the Control Type to submit.
Switch to the Submit tab, and enter
processBookingForm.do into the URL
input field. Set the Submit Format to be
XML Data (XML).
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16. Save and Active your form.

3.3

Create a new BSP Application & Controller to display the Form.

1. Go to transaction SE80 and create
a new BSP Application.
Note: Keep the name of the application
under 15 characters.

2. Create a BSP Controller named
getBookingForm.do with BSP
Controller Class named
Z_GET_BOOKING_FORM.
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3. Redefine the DO_REQUEST
method of the
Z_GET_BOOKING_FORM Class.

method DO_REQUEST.
*CALL METHOD SUPER->DO_REQUEST
*
.

endmethod.

4. Add the lines of code to remove the
header fields that are set by
default in BSP response headers.
Note: without doing this your PDF will
not show up in the browser!

5. Add the call to lookup the Form
function module name. You must
declare a variable of type
funcname for the function name to
be stored in.

runtime->server->response->delete_header_field(
name = 'Cache-Control' )
.
runtime->server->response->delete_header_field(
name = 'Expires' ).
runtime->server->response->delete_header_field(
name = 'Pragma' ).

data: l_name TYPE funcname.
try.
call function 'FP_FUNCTION_MODULE_NAME'
exporting
i_name
=
'Z_CUST_FLIGHT_BOOKING_GEBO'
importing
e_funcname
= l_name
exceptions
others
= 0.
catch cx_fp_api_repository. "#EC NO_HANDLER
catch cx_fp_api_usage.
"#EC NO_HANDLER
catch cx_fp_api_internal.
"#EC NO_HANDLER
endtry.
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6. Add a call to start the form
processing so that we can
generate the Interactive PDF.

data: l_outputparams TYPE sfpoutputparams.
*Start Form Processing.
l_outputparams-getpdf = 'X'.

Be sure to use the Flags set here! Most call function 'FP_JOB_OPEN'
changing
notably the one to get the PDF
ie_outputparams
= l_outputparams
returned back from the Function call.
exceptions
We will need this so that we can return
cancel
= 1
usage_error
= 2
to it to the client in the response object.

7. Add a call to the Form’s function
module. Notice the settings on
fp_docparams that allow for the
generation of an Interactive form.
Without these settings the form will
be generated as standard print
form.
Hint: Get the form functional module’s
generated name by testing it in
transaction SFP, and then use the
Pattern wizard to insert the function call
in your code.

8. Get the returned PDF, and store it
in a fpformoutput-pdf type variable.

system_error
= 3
internal_error
= 4
others
= 5.
if sy-subrc <> 0.
message id sy-msgid type sy-msgty number symsgno
with sy-msgv1 sy-msgv2 sy-msgv3 symsgv4.
endif.
data: fp_docparams TYPE sfpdocparams,
reservedonly TYPE BAPISBODAT-RESERVED,
booking_data TYPE BAPISBONEW,
fp_result TYPE fpformoutput.
fp_docparams-fillable = 'X'.
fp_docparams-langu = sy-langu.
CALL FUNCTION l_name
EXPORTING
/1BCDWB/DOCPARAMS
= fp_docparams
RESERVED
= reservedonly
BOOKING_DATA
= booking_data
IMPORTING
/1BCDWB/FORMOUTPUT
= fp_result
EXCEPTIONS
USAGE_ERROR
= 1
SYSTEM_ERROR
= 2
INTERNAL_ERROR
= 3
OTHERS
= 4
.
IF SY-SUBRC <> 0.
MESSAGE ID SY-MSGID TYPE SY-MSGTY NUMBER SY-MSGNO
WITH SY-MSGV1 SY-MSGV2 SY-MSGV3 SY-MSGV4.
ENDIF.
data: pdf type fpformoutput-pdf.
pdf = fp_result-pdf.
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9. Close the form processing session
by calling the FP_JOB_CLOSE
function.

10. Set the content type to be of
“application/pdf”. This way, the
client will know what kind of format
the response is, and will start the
adobe reader to display it.

11. Put the PDF into the response.

call function 'FP_JOB_CLOSE'
exceptions
usage_error
= 1
system_error
= 2
internal_error
= 3
others
= 4.
if sy-subrc <> 0.
message id sy-msgid type sy-msgty number symsgno
with sy-msgv1 sy-msgv2 sy-msgv3 symsgv4.
endif.

CALL METHOD RESPONSE->SET_CONTENT_TYPE
EXPORTING
CONTENT_TYPE = 'application/pdf'.

CALL METHOD RESPONSE->SET_DATA
EXPORTING
DATA
= pdf.
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12. Save and activate your BSP
controller. Then test your
application…you should see the
Interactive form display in the
Browswer.

3.4 Create another BSP Controller to process the form data.
1. Create a BSP Controller named
processBookingForm.do with BSP
Controller Class named
Z_PROCESS_BOOKING_FORM.
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2. Create an Attribute for your class of
type IF_IXML – this will be needed
to parse the XML from the
Interactive Form.

3. Redefine the DO_INIT method of
the
Z_PROCESS_BOOKING_FORM
Class.

4. Add code to get a reference to the
IXML service.

method DO_INIT.
*CALL METHOD SUPER->DO_INIT
*
.
endmethod.

type-pools: ixml.
class cl_ixml definition load.
g_ixml = cl_ixml=>create( ).

5. Redefine the DO_REQUEST
method of the
Z_PROCESS_BOOKING_FORM
Class.

6. Add code to get the booking data
XML from the request.

method DO_REQUEST.
*CALL METHOD SUPER->DO_REQUEST
*
.
endmethod.

data: bookingxml type string.
bookingxml = request->get_cdata( ).

Note: the form passes back its data in
XML format.

SAP NetWeaver – Using Interactive Forms in BSP Applications.

- 14 -

7. To process the XML we must create
a xml stream out of the xml we
received from the request. To do
this we need to create a Stream
Factory and then a Stream with
the Stream Factory.
8. To process the XML we also must
create a Document class.

9. Now create a Parser class so that
we can get to the data in the XML
document.

10. Call the parse( ) method on the
Parser object.

data: streamFactory type ref to
if_ixml_stream_factory.
data: iStream type ref to if_ixml_istream.
streamFactory = g_ixml->create_stream_factory( ).
iStream =
streamFactory->create_istream_string(
bookingxml ).
data: document type ref to if_ixml_document.
document = g_ixml->create_document( ).

data: parser type ref to if_ixml_parser.
parser = g_ixml->create_parser( stream_factory =
streamFactory
istream
=
iStream
document
=
document ).
parser->parse( ).

The Parser object stores the parsed
XML into the Document object we
created earlier. Now we can get the
data using the Document object.
Note: This method returns an I Type, if
it is not equal to 0, you can then
process the errors…in this exercise we
will not check for errors, but in a
production application you should! See
the documentation on iXML parser to
see how this can be done.
11. Create a Node object; this is what
is returned from the Document
object when we search for a node.

12. Call the find_from_name method
on the Document object, user
Name = ‘RESERVED’ to find the
value set for the reserved field.
And then store the value in a
String variable.

data: node type ref to if_ixml_node.

data: strChecked type string.
node = document->find_from_name( name = 'RESERVED'
).
strChecked = node->get_value( ).
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13. A check box in an Interactive Form
returns 1 for checked and 0 for not
checked, we need to check this
value you set it to ‘X’ or ‘’
depending if it is checked or
not…this is what the BAPI we will
call later requires. Create variable
of type BAPISBODATRESERVED to hold that value.

data: reserved type BAPISBODAT-RESERVED.
data: checked type i.
move strChecked to checked.
if ( checked = 1 ).
reserved = 'X'.
else.
reserved = ''.
endif.

Also note that we create a variable of
type I, and move the strChecked
variable to it. This makes it easy to use
the “if” condition on it.
14. Look up the rest of the values
using the Document object. Store
the values in a structure type
BAPISBONEW
Note: we convert the date into the SAP
internal representation.

data: custbook type BAPISBONEW.
node = document->find_from_name( name = 'AIRLINEID'
).
custbook-airlineid = node->get_value( ).
node = document->find_from_name( name = 'CONNECTID'
).
custbook-connectid = node->get_value( ).
data: fd type BAPISBONEW-FLIGHTDATE.
data: strFd type string.
node = document->find_from_name( name =
'FLIGHTDATE' ).
strFd = node->get_value( ).
CALL FUNCTION 'CONVERT_DATE_TO_INTERNAL'
EXPORTING
DATE_EXTERNAL
= strFd
*
ACCEPT_INITIAL_DATE
=
IMPORTING
DATE_INTERNAL
= custbookflightdate
EXCEPTIONS
DATE_EXTERNAL_IS_INVALID
= 1
OTHERS
= 2
.
IF SY-SUBRC <> 0.
* Do something
ENDIF.
node = document->find_from_name( name =
'CUSTOMERID' ).
custbook-customerid = node->get_value( ).
node = document->find_from_name( name = 'CLASS' ).
custbook-class = node->get_value( ).
node = document->find_from_name( name = 'AGENCYNUM'
).
custbook-agencynum = node->get_value( ).
node = document->find_from_name( name = 'PASSNAME'
).
custbook-passname = node->get_value( ).
data: pb type BAPISBONEW-PASSBIRTH.
data: strPb type string.
node = document->find_from_name( name = 'PASSBIRTH'
).
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strPb = node->get_value( ).
CALL FUNCTION 'CONVERT_DATE_TO_INTERNAL'
EXPORTING
DATE_EXTERNAL
= strPb
*
ACCEPT_INITIAL_DATE
=
IMPORTING
DATE_INTERNAL
= custbookpassbirth
EXCEPTIONS
DATE_EXTERNAL_IS_INVALID
= 1
OTHERS
= 2
.
IF SY-SUBRC <> 0.
* Something
ENDIF.

15. Call the
BAPI_FLBOOKING_CREATEFRO
MDATA function to create a flight
booking. You will need the
variables defined here to get the
returned booking number, and any
errors that may have occurred.
Note: If you do not have any Flight test
data in your system, do not call this
BAPI, but just print out the values you
that have been returned to you from
the Interactive Form (Skip this step,
and steps 16 & 17).
16. Loop at the return table that may
contain errors, put any error
messages you find into the
response.

data: bn type BAPISBOKEY-BOOKINGID.
data: return type bapiret2_tab.
data: errmsg type string.
CALL FUNCTION 'BAPI_FLBOOKING_CREATEFROMDATA'
EXPORTING
RESERVE_ONLY
= reserved
BOOKING_DATA
= custbook
*
TEST_RUN
= ' '
IMPORTING
*
AIRLINEID
=
BOOKINGNUMBER
= bn
*
TICKET_PRICE
=
TABLES
*
EXTENSION_IN
=
RETURN
= return.

data: wa type bapiret2.
loop at return into wa.
if wa-type = 'E'.
move wa-message to errmsg.
response->append_cdata( errmsg ).
response->append_cdata( ‘<BR>’ ).
endif.
endloop.

17. Append the booking number to
the response.

response->append_cdata( 'Flight booked, booking
reference number: ').
data: strBn type string.
move bn to strBn.
response->append_cdata( strBn ).
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18. Save and Activate the Controller
Class and BSP Controller. Run the
form, add some valid data into the
form and click Submit.
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